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Chapter 1 OVERVIEW 

Section A - An Introduction to Job Scheduling 
 
The Program/Project Management System (P/PMS) was designed and built to assist the Department in 
planning and scheduling the pre construction design process for trunk line road and bridge projects.  Once a 
project is selected, the project manager enters the characteristics describing the project into the system.  The 
system then creates a scheduling network using those characteristics, and using the standards provided by 
the Department's operational and supporting units, to determine which tasks will be included in the network 
and what the durations should be.  At the same time, the people required to perform the task are identified 
and added to the schedule.  Following this generation process, project managers may need to further refine 
the schedule since all projects are unique in some way.   
 
When schedules have been created and refined, they can be pulled together to summarize, analyze, and 
report on jobs, tasks, resources, and costs throughout the Department.  Project schedules are brought 
together in the system's Program Area where system and program managers can assess the impacts of 
progress, changing schedules and organizational changes.  Some information from the project schedules is 
automatically rolled together and presented in the Executive Information System where users can quickly 
review and evaluate what's going on with all projects.  Please refer to the EIS Users Guide for more details 
on that application. 
 
This document is intended to be an informal guide that explains how to DO each of the steps described 
above, and more.  The following chapters were pulled from the Combined Quick Reference/Learning Guide 
to deal specifically with how to perform some of the more common tasks in the P/PMS Job/Project Area (for 
Project Managers and Scheduling Specialists).   This guide will sometimes assume a certain minimal level 
of knowledge about P/PMS and its usage and functionality.  It is recommended that the user take the P/PMS 
Training Course before utilizing this manual, especially for the Project Manager and Program/System 
Manager portions.  If you have more questions, please call the P/PMS Hotline at (517) 373-9020. 
 
Throughout the document, reference will be made to other familiar P/PMS manuals.  Many P/PMS manuals 
exist to cover system functions, menu structures, task standards, job characteristics and much more.  The 
intent of this manual is to provide answers to most questions in a concise, easy to find way.  In many cases, 
one of the other manuals will provide detail that will not be reproduced here.  Current manuals can be found 
on the intranet at http://interchange/computing/design/ppms.htm 

Section B - Conventions 
 
Throughout this document information will be presented using the following basic standards: 
 
Menu options will appear in bold with initial upper case letters (e.g.  File, New, Job where underlined 
letters are hot keys and menu selections are separated by commas).  
 
Items of special note will be preceded by Note: and/or will be underlined or italicized. Figures are identified 
by number.
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Chapter 2 PROGRAM/SYSTEM MANAGERS 

Section A - How to Get Into P/PMS 
 
Purpose:  The purpose of this section is to detail the steps for getting into P/PMS to start working with 

jobs. 
 
Before You  
Begin:  If you do not have P/PMS, contact the P/PMS Support Team to get the software installed and 

a login password.  You will be notified when your login is available.  If it is desired, Support 
Team personnel can set up your PC to bypass the login/password screen.  Please contact us 
with any questions regarding P/PMS! 

 
P/PMS Support Team Personnel:  HOTLINE: (517) 373-9020 
Dennis Kelley (517) 373-4614 User/Printer Administration & 

Technician 
Norm Kieliszewski (517) 335-1913 Design Expert/engineering Technician 
Lenny Robinson (517) 335-3291 Consultant 
Scott Habetler (517) 335-3278 Consultant 
Melissa Tucker (517) 335-7298 Consultant 
Amy Gusfa (517) 335-2255 Student Help 

 
Procedure:  Follow these steps to get started with P/PMS. 
 

Step Action 
1 Double-click the P/PMS icon on your desktop. 

If... Then... 
A. A login screen 

appears 
Type in your login name, ENTER, 
and your password, and proceed to 
the next step. 

B. The Main Menu 
appears 

Proceed to the next step.  
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Figure 1 
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 Section B – How to Find Out What Jobs are Ready for Program Addition 
 
Purpose:  The purpose of this section is to detail the steps for identifying jobs to be added to the P/PMS 

Statewide Master Program. 
Before You  
Begin: Jobs or versions that have been submitted for programming in P/PMS are marked as refined.  

See also Chapter II - Project Managers, Section A (Page 3) for categories of job networks 
and their descriptions.  

 
Procedure: 

Step Action 
1 Read Section E through Part V to understand how to use the Selection Screen. 
2 If you are not already in the Program Area of P/PMS, select File, Go to Program 

Area. 
3 Select Listings, Refined Jobs. 
4 A selection screen will appear.  Fill out the fields to narrow your search, or blank out 

the fiscal year fields to see all refined jobs.  Use the Sort button to choose your sort 
order. 

5 The Refined Jobs Listing appears (Figure 2 below), showing information including 
the version submitted, target PC and Letting, and the date it was submitted. 

6 Using the Refined Jobs Listing for reference, each of the submitted versions needs to 
be checked for: 

• Correct target PC and Letting (either approved in MPINS or existing 2604). 
• Network schedule not late (see Late Criteria - Page 4). 

 
7 Check for the target PC and Letting to match MPINS by opening MPINS and: 

• Click the Job Locator button 
• Type in the job number and select Change Request 
• Click OK 

Figure 2 
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Section B – How to Find Out What Jobs are Ready for Program Addition, (continued) 
  
 
Procedure: 

Step Action 
8 You should see the MPINS Change Request Summary Screen. Click on the bottom-

most change request.  If it has not been a[[roved, and is In Review or Follow-Up, do 
not yet program the version. 

9 Select Change Request – 2604 – date info 
10 Check the Change Request – Date Information screen that comes up.  The column of 

dates on the right includes the PC and Letting to be matched by the version.  Note: 
The letting date may not match exactly, but needs to be in the same month and year. 
The same applies to the P.C. 

11 If… Then… 
A. PC and Letting do not match 

the latest 2604 
Contact the PM and inform them 
the version can not yet be 
programmed. 

B. PC and Letting match the 
2604 

Check to see if the latest 2604 is 
approved (step 11)  

12 If… Then… 
A. The latest 2604 is In Review 

or Follow-Up (see step 7) 
Wait for the 2604 to be approved 
before proceeding. 

B. The latest 2604 is approved 
(see step 7) 

Proceed to step 12. 
 

13 In P/PMS, click Reports, Jobs/Projects, PC and Letting Dates. (Check the PC and 
Letting Dates Report.)  You will see the Scheduled vs. Approved Plan Completion 
and Letting Dates for your network. See Figure 11. 

14 Compare the scheduled dates to the approved dates for the Plan Completion and 
Letting, taking note of how far in the future they are form today, and recognizing the 
float. 

15 Apply the following criteria to determine if your network is late (late network will 
not be approved/programmed in P/PMS): 
 
A job is late if the approved date for the PC and/or Letting is… 
…within the next 2 months and the schedule is > 5 days late (float is worse than -5). 
…within the next 3 months and the schedule is > 10 days late. 
…within the next 6 months and the schedule is > 15 days late. 
…within the next year and the schedule is > 30 days late. 
…within the next 2 years and the schedule is > 50 days late. 
…within the next 3 years and the schedule is >70 days late. 
…within the next 4 years and the schedule is > 90 days late. 
…4 years or greater and the schedule is >110 days late. 

16 Note all jobs with correct target dates, approved 2604’s, and good schedules. 
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Section C - How to Add/Remove Schedules To/From the Program/Scenario 
 

Purpose: The purpose of this section is to detail the steps for identifying and adding jobs to the P/PMS 
Statewide Master Program.  Once schedules are added to a program they can then be used to 
perform resource scheduling, resource summarization, generate resource histograms, perform 
cost and hours summarizations, and organizational and work type rollups.  All of this 
information can then be used to do analysis of the program.  Program Managers can find out 
where their program is and where it is going, and then the Program Manager can make 
informed decisions about where it should go. 

Before 
You Begin Because the P/PMS Statewide Master Program of jobs is protected, you must first create a 

scenario of jobs, much like creating a version of a job.  You may then add or delete jobs and 
versions in the scenario, and then replace the P/PMS Statewide Master Program with the 
scenario.  Scenarios may also be used to perform program what-ifs.  Note:  In the scenario to 
replace the Program with, you should delete the ‘old’ version 1 of jobs you want to replace 
with the new versions, and add the new versions (see Part II). 

Part I – Creating a Scenario 
Procedure: 

Step Action 
1 From the Program Area menu, select File, New, Scenario.  You will then see the 

window in Figure 3 (next page).  Note: Scenarios are automatically identified in 
much the same way as versions, but use letters instead of numbers.  The created 
scenario will have the next letter available in series, usually A for the New Program 
Scenario. 
 

2 Fill in the description of the scenario for further identification. 
 

3 Fill in the Resource Availability Profile you wish to use with the scenario.  This will 
typically be the same one used with the Program, which is Profile 1.  
 

4 Click on Update, and then Exit. 
 

5 You will be asked if you wish to copy the program or a scenario (Figure 4 - next 
page). 

6 If… Then… 
You want to build the scenario from 
scratch Click cancel.  . 

Go to Part II 

You want to copy the program or a 
scenario   

Click OK. 
 

7 You will be presented with a menu of scenario choices to copy.  You will want to 
select the Statewide Master Program if you wish to update it. 
 

8 You will need to wait while P/PMS copies the program/scenario to the new scenario. 
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Section C - How to Add/Remove Schedules To/From the Program/Scenario, (continued) 

Part II –Adding or Deleting Jobs from a Scenario 

Procedure 
Step Action 

1 From the Program Area menu, select File, Open, Scenario. 
2 Select the scenario you wish to work on from the pop-down menu 
3 Select Edit, Scenario Jobs. 
4 If… Then… 

A. You want to delete jobs from 
the scenario 

1. Click on Subrec. 
2. Scroll or use Find to locate the job 

you wish to delete. 
3. Click Delete. 
4. Click OK for verification. 
5. Repeat 2 - 4 for each job to delete 

B. You want to add jobs to the 
scenario 

1. Click on Subrec. 
2. Click on New. 
3. Enter Job Number and Version 

Number. 
4. Use up or down arrow to save. 
5. Repeat 2-4 for each job to add.  

5 Click Exit when finished.  You will need to wait while P/PMS adds your jobs to the 
scenario. 

 

Figure 3 

 

Figure 4 
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Section C - How to Add/Remove Schedules To/From the Program/Scenario, (continued) 

Part III – Replacing the Program with a Scenario 
Purpose This part outlines steps to replace the Program with the Scenario you have created, which is 

also how a job’s version replaces the original in the Program. 
Before 
You Begin Because replacing the Program requires extensive data manipulation, it is recommended that 

this process be conducted at the end of the work day, or else at the very beginning, to avoid 
problems with data sharing. 

 
Procedure  

Step Action 
1 From the Program Area menu, select File, New, Statewide Master Program. 

 
2 You will be notified and asked if you want to continue.  Click OK to verify. 

 
3 Select the scenario you wish to replace the Program with from the pop-down menu. 

 
4 P/PMS will check the scenario you selected for a missing availability profile, the 

presence of generic jobs/versions, for jobs/versions whose schedules have been 
modified since their inclusion in the scenario, and for jobs/versions with status 
exceptions in MPINS.  In each of these cases, an informational message will instruct 
you what to do to fix the scenario before programming it. 
 

5 If there are no exceptions, you will be asked to continue.  Click OK. 
 

6 There may be other users in P/PMS when you are attempting to replace the Program.  
If so, an informational message will alert you to these other users.  Click OK to see 
the list. 
 

7 If you believe that the number of users will not be adversely affected by any data 
sharing problems, click OK when asked to continue.  Otherwise, click Cancel. 
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Section D - How to Change Resource Availabilities 
 
Purpose This section provides information and steps concerning how to add and update resource 

availabilities in the resource availability table. 
Before 
You Begin A resource availability profile is used to tell the system how many people are available to do 

work on any given day.  The profile can be used by the system to Resource Level the 
program, and to compare against the required resources to show the manager if there are 
enough people to get the work done.  For this manual we will only discuss modifying an 
existing profile.  

 
Procedure 

Step Action 
1 From the Program Area, select File, Open, Resource Availability Profile.  A pop-

menu of profiles will appear. 
2 Select an existing profile.  Typically, you will work with Profile 1. 

 
3 Select Edit, Resource Availability Profile Table.  You will see a window like Fig. 5. 
4 The first column represents the Org Code, the second column is how many people per 

day are available to work from the organization - originating from the availability 
forms provided to & received from units.  The next column shows the calendar that 
the resource uses.  The next two columns show the dates that the resource will be 
available. 

5 Modify existing availabilities by using the Find feature or scrolling to the record you 
wish to change, or click New to add more.  Calendar 2 is the MDOT work day 
calendar. 

6 Use the mouse or arrow keys to move between fields and edit. 
7 Click Exit when finished. 

Figure 5 
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Section E - How to View Reports on Programs 
 
Purpose The purpose of this section is to describe how to run common reports on groups of jobs 

(‘programs’) in P/PMS that detail certain types of information, and what those reports show. 
Before 
You Begin Several pre defined listings, reports and graphs are available under the Listings and Reports 

menus that let you review the progress your program is making, find out where problems 
may have arisen and communicate your situation to interested parties.  Many predefined 
reports are intended to provide information about job status and to highlight problems.  See 
Appendix A for details on using the report viewer.  Common items of interest are listed 
below, arranged according to the menu structure. 

 
  The Selection Screen is the heart of the majority of the Listings and Reports available. 

Figure 6 

 
 

The Selection Screen allows the user great power, and yet flexibility to customize lists and 
reports to view just the data that the user would like to see.  Before you begin using the 
listings and reports, we will define the items on the Selection Screen for usage.  

 
Note: Many combinations of selection criteria are available for use, but certain listings and 
reports may preclude the usage of certain items on the Selection Screen.  These will be 
ghosted and unavailable to the user.  Also, blue buttons next to categories will access pop-
down menus of the choices available, and some combinations of selection criteria may yield 
no results. 
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Section E - How to View Reports on Programs, continued 

Part I – Main Criteria 
Item Description 

Fiscal Year Allows selection of jobs by Fiscal Year of target (approved) letting; i.e. Fiscal 
Year 2002 covers jobs targeted for letting between 10/1/01 and 9/30/02. 

Quarter You may further refine your year selection by choosing jobs with target 
lettings in a certain quarter of the fiscal year. 

Let Month The user can select jobs with a target letting in a specific month of a fiscal 
year. 

Region The user may select jobs located in one of the seven regions of the state. 
 

TSC The user may select jobs within the counties and coverage area of a specific 
TSC. 

 
Build 

Michigan 
Build Michigan jobs are specifically identified in MAP, and thus P/PMS, as 
highest priority jobs.  These jobs are typically requested by the Governor. 

 

Part II – Jobs Owned By: 
Item Description 

Organization Allows selection of jobs by Project Managers within specific units. 
Manager Allows selection of jobs owned by specific Project Managers 

 

Part III – Jobs Grouped By: 
Item Description 

Job Group Allows selection of 1 of 6 different Job Groups, groupings of jobs based on 
Funding Templates into larger categories such as Bridges. 

Work Group Selection of Work Groups picks jobs within 1 of 6 Work Group areas, such as 
Roadway jobs, Bridge jobs, or Landscaping jobs. 

Job Type Job Type selection further narrows choices to specific Job Types, based on Job 
Groups, but more defined, like Expand: New Routes or Preserve: Other. 

Work Type The user may select jobs of a specific Work Type, the 3-digit code defining the 
main type of work on a job.  Many different options are available. 

Funding 
Template 

Users selecting a specific Funding Template may select jobs from which the 
majority of money for the Design Phase comes from 1 of 34 specific 
categories. 

Task 
Number 

Users may choose to select jobs which contain a specific task number within 
their critical path networks. 
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Section E- How to View Reports on Programs, continued 

Part IV – Tasks By:  
Item Description 

 
Time Frame For Task Reports, the user may select tasks scheduled to start or finish within 

the next 1 month, 4 months, 1 year, or 2 years from today. 
Resource 

Unit 
The user may select tasks performed by various resources from a pop menu. 
 

Resource 
Group 

Selection of all tasks to be performed by a group of resources may be made.  A 
pop-down menu includes Real Estate, North Region, and Grand Region Project 
Development/Design, among others. 

Part V – Sorted By and Report Type 
Item Description 

Sorted By The user may select to have items on the listing or report sorted by Region, 
Project Manager, Approved Letting, or Work Type.  The default sort is by 
Control Section and Job Number. 

Report Type Report types may vary, depending on the information the user is interested in 
for certain reports.  Report types are keyed to Design, Real Estate, 
Environmental, Traffic & Safety, Capital Preventative Maintenance, and 
Region Design. 

Part VI – Common Listings and Reports 
Listings 

Job Involvement by Unit - This listing allows you to select a single resource and see 
all jobs in the program that the resource in involved in, including their approved and 
scheduled plan completion and letting dates, plus the project manager. 

 
Programmed Jobs - The user uses the selection screen to provide a specific list of 
jobs that are currently in the Statewide Master Program, presenting general job details 
that include project manager, work type, target PC and letting, and construction cost.  
A similar report highlights Scenario Jobs. 

 
Refined Jobs - See Section B, through Step 4. 

 
Unrefined Jobs - Selection criteria will provide a listing of jobs that have networks 
and management units, but have not yet been submitted for programming in P/PMS.  
Again, general job details are presented. 

 
Network Status - Provides a listing organized into the 6 Work Groups, identifying 
for each, given the selection criteria: 1) total number of networks in the group, 2) 
number and % of networks that are new, unrefined, refined, and programmed, as well 
as on time and late networks. 
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 Section E- How to View Reports on Programs, continued 
 

Part VI - Common Listings and Reports, continued 
Reports 

Program/Project 
The Project Status Report provides the basic information for selected jobs, 
plus extra info on network status, and approved and scheduled dates for the 
major milestones on a job to show whether it is on time or not. 

Custom Report - allows usage of the selection screen to choose the 
data the user would like to view. 
Combined Report - the user can view a report for all Major Programs 
in a specific fiscal year.  
Historical Report - this generates a report for a selected Job Group that 
can view the status of a past fiscal year, at the beginning of a specific 
week (collection started 9/11/00). 

The Program Status Report provides for an overview of an entire selected 
program for major milestones, showing number of originals, approved, and 
actuals to date, as well as the gap and what % are on target.  It also shows 
projected lettings by month and costs as shown in MAP, approved in P/PMS, 
and scheduled in P/PMS. 

Custom Report - same as above 
Combined Report - same as above 
Historical Report - this generates a report for all programs that can 
view the status of the current fiscal year, at the beginning of a specific 
week (collection started 9/11/00). 

The Program Performance Report utilizes the selection screen to choose the 
data you wish to view.  The report itself provides a view of approved letting, 
scheduled letting, float, and construction cost for the jobs selected. 

 
The PC and Letting report here uses the selection screen to choose jobs to 
see on the PC and Letting date report, which shows the approved dates, 
scheduled dates, and float for the PC and Letting for the selected jobs. 

 
Tasks 

Use the Late Tasks report to determine which tasks in a particular program 
are unfinished and late.  This report shows the Approved, Scheduled, and 
Actual starts and finishes for all late tasks in a particular network. 

 
The Milestone Status report can be used to show the status of all of the 
milestones for a program.  This report also shows the Approved, Scheduled 
and Actual dates for each milestone.  This report will let the user know ahead 
of time which milestones are in jeopardy of slipping behind schedule and 
which have missed their completion dates. 
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Section E- How to View Reports on Programs, (continued) 

Part VI- Common Listings and Reports, (continued) 
 

Milestones 
The Late Milestones report lists all late milestones.  The late milestones may 
come from all jobs, by Project Manager, Squad, etc.  The report is similar to 
the Late Tasks Report, but consists of Milestones only. 

 
The Major Milestone Gantt Chart gives the same information as in the 
Network Milestone Report in graphic form.  Schedule dates for each 
milestone are represented as diamonds placed against a time line. Schedules 
for each WBS task group are shown as horizontal bars.  The report is grouped 
by job number for a multi-job project. 

 
Resource 

The Responsibilities Work Schedule can select tasks using the selection 
screen, and the report provides information on durations, budgeted and actual 
labor hours, and approved, scheduled, and actual start and finish dates, as well 
as float. 

 
The Resource Histogram allows the user to select a resource (index or 
organization) code and a start and finish date to view a chart showing the 
combined work in labor hours versus the unit’s availability over the chosen 
time period. 

 
A Resource Summary report allows the user to select one or more resources 
to view over the user-input time frame.  The resultant report shows histogram 
information specifics in tabular form, along with breakdowns of hours 
required and available per day, and average overload/under load per day. 

 
Payroll 

Payroll reports may be based on either DCDS (more detailed) or P/PMS (less 
detailed). You can use these reports to see what units/people have logged time 
and money against a given job, or you can see how many hours and dollars 
have been logged by your unit against all jobs, among other things. 

 
Under DCDS, you may see reports by job, employee, or resource.  By job, 
you may choose the fiscal year of info you want.  By employee and resource, 
you can pick the FY and quarter.  Output may include Job Number, Task 
Number, Resource, Employee Name, Actual Hours, Actual Costs, Pay Period, 
and Calendar Year. 

 
Under P/PMS, you have the option of payroll by job, manager, task, or 
resource.  This report covers all jobs and timeframes.  The subsequent picks 
work similar to the DCDS.  Output may include Job Number, Resource, Task 
Number and Description, Actual Hours, and Actual Costs. 
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Section F - How to Quit, Close, Exit, Log Off or Out, or Otherwise Leave the System 
 
Procedure 

Step Action 
1 Choose Exit from the File Menu. 

 
• Note that it is not necessary to close your template, job, scenario, or program 

session before exiting. 
• Use of the Window Control button (the “X” sign in the upper right of the 

window) to close windows is not recommended, as this will kill your 
sessions abnormally, and may leave things running on the P/PMS server 
which may preclude you from accessing the system later, or  preclude other 
users from accessing certain system data. 
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Chapter 3 APPENDICES 

Appendix A - The View File Window 
 

The window, in which listings and reports are displayed, shown below, is called the View File window. 
 
This screen allows you to: 
 

1. Scroll up and down the listing using the vertical scroll bar 
 

2. Scroll right and left in the listing using the horizontal scroll bar 
 

3. Search for a text string in the listing 
 

4. Print the listing 
 

5. Save the listing to a file 
 

6. Display listing files you have saved (by clicking on Utilities, View a File) 
 

 
You can also maximize the View File window to see a larger part of the listing. 
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Appendix A - the View File Window, continued 
The menu bar at the top of the screen gives you access to three menus:  
 

• File 
• Goto 
• Help 

 
In addition, there are seven buttons at the bottom of the screen. The functions assigned to menu items and 
buttons are summarized below. 
 

MENU BAR FUNCTIONS: VIEW FILE WINDOW 

MENU MENU ITEM FUNCTION 
File 
 Print Prints the listing on the default printer. 
 Save As  Saves the listing to the file you specify in the Prompt 

pop up window. 
 Exit Closes the View File window and returns you to the 

P/PMS area window. 
Goto 
 Top Moves the View File window to the top of the listing. 

 
 Bottom Moves the View File window to the bottom of the 

listing. 
 Left Moves the View File window to the left side of the 

listing. 
 Right Moves the View File window to the right side of the 

listing. 
Help 
 About Viewfile Displays information about the View File window. 
 About Windows Displays information about X Windows. 

 

BUTTON BAR FUNCTIONS: VIEW FILE WINDOW 
BUTTON FUNCTION 
EXIT Closes the View File window and returns you to the P/PMS area 

window. 
CONTINUE Allows processing to continue in the P/PMS area window. 
SELECT Displays in a View File window the file you select in the File 

Requestor pop-up window. 
ANOTHER Displays a selected file in another View File window. 
FIND Searches for the text string you enter in the Prompt pop-up window. 
REPEAT Searches for the next occurrence of the text string. 
PRINT  Prints the listing on the printer you select from the pop-up window. 
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Appendix B - Constraint Types 
 
Constraints are the means which will be used to show how the activities relate to each other.  The following 
diagram lists the major types. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Finish to start means that activity B cannot start until activity A is finished.   
 
Start to Start means that Activity A must start before activity B can start.   
 
Finish to Finish means that Activity B cannot finish until activity A finishes.   
 
 
Each of these types of constraints may also contain a delay inserted between the two tasks involved. 
 
There is one other kind dependency that exists - Start to Finish - but it is rarely used, so it is not included in 
the above. 
  
  

A B A B

A B

Finish to Start Start to Start

Finish to Finish  
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Appendix C - Glossary of Terms 
 
2604 Form.  A change request form in MPINS used to obtain authorization for such changes to a job as 
adding or deleting phases, and splitting a job, as well as changes to a job=s cost, major work type or work 
performed, location, financial cost divisions, and major milestone dates.  This form is usually submitted 
before creating a version of a job.  (See Version) 
 
Actual Finish Date (AF) - The actual point in time that work is finished on a task.  (Note: in some cases, 
the task is considered “finished” when work is “substantially complete”). 
 
Actual Start Date (AS) - The actual point in time that work started on a task. 
 
Approved Finish Date - The target point in time that work should finish on a task in order for the job to 
meet its targeted plan completion date. 
 
Approved Start Date - The target point in time that work should start on a task in order for the job to meet 
its targeted plan completion date. 
 
Characteristics - Items in the scope of a job that make it unique, including work type and region, road 
class, FHWA involvement, subgrade work or work outside existing shoulders, and many more.  
Specifically, these items of scope determine what tasks are in P/PMS job networks, their durations, and 
more.  
 
Constraint - A dependency between two tasks, or between a task and a milestone.  The four types are: 

• Finish-to-start - the “from” task must finish before the “to” task can start. 
• Finish-to-finish - the “from” task must finish before the “to” task can finish. 
• Start-to-start - the “from” task must start before the “to” task can start. 
• Start-to-finish - the “from” task must start before the “to” task can finish. 

 
Construction Cost - The programmed A-phase amount minus the estimated Construction Engineering (CE) 
amount.  Both values are retrieved from the MAP database and are shown on the MPINS Job Info Screen. 
 
Critical Path - The series of activities determining the earliest completion of the project.  The critical path 
will generally change from time to time as activities are completed ahead of or behind schedule.  Although 
normally calculated for the entire project, the critical path can also be determined for a milestone.  The 
critical path is usually defined as those activities with float less than or equal to a specified value, often zero. 
 
Duration - Number of work days (not including holidays/other non-working days) required to complete a 
task. 
 
Float - The amount of time, in days, that a task may be delayed from its approved dates without delaying 
the project finish date.  Float is a mathematical calculation and can change as the project progresses and 
changes are made to the project.  Also called slack time, total float, and path float. 
 
Generic Job - A job containing all of the tasks, milestones, and constraints necessary to constitute a 
network, but missing the necessary Management Units to finish assigning all resources to tasks. 
 
Job Schedule - The planned dates for performing the tasks and for meeting the milestones. 
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Appendix C - Glossary of Terms (continued) 
 
Labor Hours - The amount of actual “hands-on” time a resource (work unit) spends performing a task or 
group of tasks. 
 
Letting - The date that a job is put up for bid by contractors. 
 
Management Units - Work units (resources) involved in major portions of a job & the P/PMS network of 
tasks. 
 
MAP - Michigan Architectural Project.  The MDOT corporate database. 
 
Milestone - A significant event in the job, usually the completion of a major deliverable. 
 
MPINS - Michigan Project Information System.  The user interface to the MAP database. 
 
Network Analysis - The process of identifying early and late start and finish dates for the uncompleted 
portions of project activities. 
 
Network Logic Diagram - A schematic display of the logical relationships of project tasks.  Always drawn 
from left to right to reflect project chronology.  Often referred to as a “PERT chart”. 
 
New Job - A valid job whose basic data has been loaded from MAP and needs a P/PMS network created.  
Valid jobs include: 

• Concepts with job numbers not beginning with 9, with valid P/PMS work types, region codes greater 
than 0, and which will be let by MDOT during or after the current fiscal year. 

• Approved or active trunk line jobs, with job numbers not beginning with 9, valid P/PMS work types, 
region codes greater than 0, and which will be let by MDOT during or after the current fiscal year 
(or Study jobs). 

 
Plan Completion - The date at which all plans are complete, and the job is turned in to Specifications and 
Estimates for packaging to be advertised and let. 
 
P/PMS - The Program/Project Management System. 
 
Program - A group of related projects managed in a coordinated way.  Programs usually include an element 
of ongoing activity. 
 
Programmed Job - A job that has been approved and added to the P/PMS Statewide Program.  These jobs 
require updating and monitoring for progress. 
 
Project - A temporary endeavor undertaken to create a unique product or service. 
 
Project Management - The application of knowledge, skills, tools, and techniques to project activities in 
order to meet or exceed stakeholder needs and expectations from a project. 
 
Project Manager - The main person responsible for developing schedule & plans for a job/group of jobs. 
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 Appendix C - Glossary of Terms (continued) 
 
Refined Job - A job that has a version waiting to be included in the P/PMS Statewide Program.  The 
version must have satisfactory dates and/or coincide with an approved 2604 before it can be “programmed” 
n P/PMS. 
 
Resource – A unit that performs at least some of the work on the task or tasks they=re involved with. 
 
Scheduled Finish Date - The planned point in time that work will be finished on a task. 
 
Scheduled Start Date - The planned point in time that work will be started on a task. 
 
Scheduling Specialist - The “right-hand” of a project manager, whose duty with regards to P/PMS is to 
perform the ground work necessary to create and update the P/PMS network for a job. 
 
Target Date - An imposed date which constrains or otherwise modifies the network analysis.  Target dates 
are set approved dates from which the network schedule is calculated.  These include the Target Start (Task 
0000), Target Plan Completion, Target Letting, Target Finish (Task 9999), and Target Float. 
 
Task - An element of work performed during the course of a project.  A task has an expected duration, and 
expected cost, and expected resource requirements. 
 
Ungenerated Job - A job that has been opened in P/PMS.  The job may even have some characteristics 
entered, but does not yet have a network generated. 
 
Unrefined Job - A job containing all of the tasks, milestones, constraints, and resources necessary to 
constitute a network, but that needs to be checked, updated, and verified to ensure the network correctly 
reflects all work to be done. 
 
Version - A copy of a job network, with which a project manager or scheduling specialist is able to make 
changes to the network.  This is sometimes utilized to perform a “what-if?” scenario. 
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Appendix D - Entry of Actual Start and Finish Dates 
 
Other than in P/PMS itself, actual start and finish dates get to us through MAP from other systems, MPINS, 
and now from DCDS.  The MPINS and DCDS methods are presented here. 

How to assign an employee to a P/PMS Task in MPINS 
 
This function can be performed by the Supervisor of the Unit for an employee assignment to be made. 
 

1. Identify the job record for which an employee assignment is to be made as described in How to 
Identify Desired Records. From the Job List, select Job/Phase Task Status from the menu bar, and 
in the Job Locator select Jobs and Phase Task Status. 

 
2. In the Phase Tasks section of the Phase Task Status window, use the vertical scroll bar to locate and 

select the PPMS Task Number/Unit record in which an employee assignment is to be made. 
 
3. In the Task Status section of the window use the pick list associated with the Employee field to 

select the employee to be assigned to the task. 
 
4. Save the changes by clicking on the Save tool bar button. 

 
 

 
5. Repeat from step 2 as desired. When done, the user can close the window by 

clicking on the Close tool bar button. 
  

 

How to record dates for P/PMS Tasks in MPINS 
This function can be performed by the Unit Leader or Project Manager for a given job, and by the 
Supervisor of the Unit or an employee they designate as assigned to the Task. 
 

1. Open the Job Locator by clicking on the Job Loc. tool bar button.  The Job Locator window opens, 
as illustrated here.  

 
2. Select Job at the top of the above window. 

 
3. Enter the desired job number in the Job # field. 

 
4. Select Phase Task Status in the Locate section of the 

window. 
 

5. Select OK at the bottom of the window to proceed. 
  
 
 



P/PMS Quick Reference/Learning Guide 

APPENDICES 3-8 

Appendix D - Entry of Actual Start and Finish Dates (continued) 
 

6. The Phase Task Status Screen opens, and defaults to select Incomplete Tasks. 
 
7. In the Phase Tasks section of the Phase Task Status window, use the vertical scroll bar to locate and 

select the PPMS Task Number/Unit record in which dates are to be recorded. 
 

8. In the Task Status section of the window enter any of the Est. Completion Date, Actual Start 
Date, Actual End Date fields as appropriate. 

 
9. Save the changes by clicking on the Save tool bar button. 

 
10. Repeat from step 2 as desired. When done, the user can close the window by clicking on the Close 

tool bar button.        
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Start and Finish Dates in DCDS 
 
The P/PMS Team has developed a way for users to input P/PMS task start and finish dates through DCDS 
(current methods of entering actuals in MPINs and P/PMS are still supported).  Task actuals can now be 
entered through the Multi field in DCDS.  This is accomplished by entering a 5 digit code SMMDD or 
FMMDD where S indicates a start, F indicates finish, MM represents the month and DD represents the day.  
In the case that a task was started and finished during the same pay period the two codes can be combined 
resulting in SMMDDFMMDD.  For the example below: 
 
S0612 - would be an actual start date of June 12, 2000 (year from pay period) for task 3310. 
F0622 - would be actual finish date of June 22, 2000 for task 3310. 
S0612F0616 - would be a Start and Finish in the same pay period for task 2320.  
 
AG1 (task code), Project (Job Number) and Index (old Org. Code) fields must be present for the actuals to 
be valid.  The Index (old Org. Code) will be checked to insure that the unit listed is the Responsible Unit for 
the task. 
 
Note: A delay of up to 3 weeks is possible for P/PMS to receive the DCDS information. 
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Appendix E - Network Logic Editor (NLE) 
 
The Network Logic Editor (NLE) is an X Windows interface enabling you to use a mouse to interactively 
create and modify a job network on the computer screen. You can use the Network Logic Editor to: 
 

• Create or delete activity boxes and constraint lines with the mouse. 
• Modify activity or constraint information through a data entry screen 
• Analyze and route a network 

 
 

Using the Network Logic Editor to modify your network 
 
To activate the Network Logic Editor after you have created or copied a network: 
 

1. Click on EDIT from the CSS main menu bar 
2. Select Network Logic Editor 

 
If you are creating a network Task by Task, the Network Logic Editor screen will appear as a blank sheet. 
 
If you have created a network by Job Type or Characteristics, the Network Logic Editor Screen will have 
the tasks that represent your network. 
 
The following will describe the operations that you can perform within the Network Logic Editor. 
  

To Add an Activity to your network 
 

1. Rest your mouse cursor on a blank area of the NLE screen 
2. Press and hold the left mouse button 
3. Drag the cursor to the right or left (about an inch) and release 

 
An activity box will be inserted into your network.  Please be aware that information will need to be added 
to this activity.  This will be explained throughout this section. 
 

To Add an Activity Constraint 
 

1. Click one time on the activity that you wish to impose a constraint.  The activity should be 
highlighted with a bolded outer edge 

2. Place your mouse cursor just inside the activity box 
3. When the cursor turns into an plus sign (+ ) , Click and hold the left mouse button. 
4. Drag the cursor to the activity with which you wish to constrain your activity 

 
Where you place and release your cursor within an activity will determine your constraint type.  The 
following describes activity constraints within the NLE. 
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Start to Start (SS) - Place the cursor on the left side of your task and draw a line to the left side of the task 
with which you wish to constrain. 
 
Finish to Start (FS) - Place your cursor on the right side of the preceding task and draw a line to the left side 
of the succeeding task.  
 
Finish to Finish (FF) - Place your cursor on the right side of the task box and draw a line to the right side of 
the task with which you wish to constrain your selected task. 
 

To view or Edit a constraint record 
1. Double click on the constraint line 

To Edit an Activity  
1. Double click in the center of the activity box 
2. Click at the bottom of the active window 
3. Make modifications (See section on modifying activity data) 

To Delete an Activity  
1. Select the activity 
2. Click on EDIT form the NLE menu bar 
3. Click on Cut to remove the activity  

 
The following chart describes the basic functions within the NLE: 

To: Action 
 

Create an activity box  Press and drag in empty space in Edit window 
Create a constraint line Press within a box: drag to another box 
Select an activity or constraint Click on desired activity or constraint 
Edit an activity or constraint Double Click on selected activity or constraint 

or 
Select activity or constraint: select Forms option 
from Data menu 

Delete  Select Item: use Cut option from Edit menu 
Move an activity When the hand icon is in an activity box, press and 

drag 
Paste Select item: use Cut or Copy: place cursor, press 

right mouse button, use Paste from Edit Utilities 
pop-down menu 

Route  Select Route option from Tools menu 
Analyze Select Analyze option from Tools menu 
Exit Select Exit option from Tools menu 
 
  
 
 


